
®

User Guide



Congratulations on ordering your life-changing website.

This guide tells you everything you need to know about the launch of your new website as

well as how to edit and maintain your website in the future.

Although we love seeing your happy smiling face, there’s no need for you to keep popping

into the store while we build your website. We’ve developed a clever online tool called Update

Centre to keep in touch. We’ll send you messages through Update Centre while we’re building

your site. You’ll use it to approve or request changes and to send us images and text. It means

that we all know what stage we’re at.

Once your website is launched, you’ll still use Update Centre to update your website.

Welcome to
websitesbyprinting.com
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>>YOUR UPDATE CENTRE LOGIN DETAILS

Username:

Password:



Building your website
- in three easy steps
Here’s a summary of the steps to building your website.

STEP ONE - See pages 4-5
WE design your Master Page.

STEP TWO – See pages 6-7
WE build a working website and

add your content.

STEP THREE – See pages 8-17
WE launch your website and

make it live.
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YOU approve your Master Page Mock-up.

YOU approve the Dynamic Proof.

YOU can make changes to the

content of your website.

>>>

>>>

>>>



Approving the
Master Page Mock-up
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When your master-page mock-up is

completed you will receive an email

requesting that you sign in to Update

Centre at www.updatecentre.com.

You’ll be taken to ‘My Websites’ which

lists websites you’ve ordered and their

current status.

To view your Master Page Mock-up, click

on the ‘MANAGE SITE’ link on the right.

This will take you to your website control

screen, then click on ‘View Messages’ (all

messages sent to you can be found in here) you’ll be able to see a message saying your Master

Page Mock-up is awaiting approval. Click on the icon on the left to view the proof, then follow

the link to open the mock-up.

You’ll see the elements of the website that will appear on every page including the logo

header, footer and menu bar. This is just an image at this stage and is not a working website

yet. When you’ve checked this mock-up, you have four options from the drop down menu:

Approved – No changes
If you've thoroughly checked the mock-up design of your

website and you're happy to proceed, choose this option.

Approved subject to changes
If your changes are simple and not too numerous,

please note details and choose this option.

Further Mock-up required
If you require changes along with another proof,

please note details and choose this option.

I’ll approve later
If you’ve not got time right now, you can approve later.

Click here to open mock-up



Please bear in mind that any changes you make that were not included in your original brief

will be charged at our usual hourly artwork rate.

Once you have approved this Master Page Mock-up, we will ‘code’ your design to turn it into

a working website. After you have approved the Master Page Mock-up we will:
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✓Master Page Mock-up Check List
Remember – this is just a ‘mock-up’. Colours and layout could
look slightly different once we have coded the website.

Is everything spelt correctly? Imagine having a spelling mistake
on the header on every page of your website?

Does the menu bar have the correct number of links, in the
correct position with the right spelling? Remember, we can’t
add any more once we’ve coded your website.

Are the images correct and in the right place?

Once you have approved your Master Page Mock-up, we’ll add your content – that’s the text

and images we have agreed to include for you.

If you haven’t supplied these details yet, please send them to us now, so there are no

unnecessary delays in getting your website live.

This means that we can’t make ANY changes to the Master Page after this point. To avoid

extra costs or delays, it is really important that you are 100% happy with your Master Page

design. The checklist below should help:



Once we’ve ’coded’ your website and added your content, we’ll send you an email asking you

to sign in to Update Centre at www.updatecentre.com to approve your Dynamic Proof.

Sign in and you’ll be taken to ‘My Websites’.

To view your Dynamic Proof, click on

the ‘MANAGE SITE’ link on the right.

Click on ‘View Messages’ and you’ll

see a message saying that your

Dynamic Proof is awaiting approval.

Click on the icon on the left to view

the proof and then follow the link to

open the proof.

This will show your actual working

website, with links which work and

your content included on every page.

The master page design is incorporated

into the design of the pages.

Please check through this dynamic proof. When you’ve done so, you’ll have four options from

the drop down menu just as you did when approving the Master Page Mock-up; Approved

– No changes, Approved subject to changes, Further Proof required and I’ll approve later.

Please bear in mind that any changes you make that were not included in your original brief

will be charged at our usual hourly artwork rate.
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Approving the
Dynamic Proof



Once you have approved the website to go live, you can use Update Centre to make as many

changes yourself as you like for free. If you’d like us to make further changes, that’s fine.

We’d be delighted. Thanks for asking. We’ll do these at our normal hourly artwork rate.

The checklist below should help ensure you don’t need us to make any further changes:
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✓Dynamic Proof Check List

Is the content in the correct place? (Remember you can make
changes to spelling and punctuation later yourself).

Are the links all linking to the correct pages?

Are the correct images being used?

Is the correct text on the correct page?

Once you’ve approved this Dynamic Proof, we’ll make your website go live on the web. It can

take up to 72 hours before your website is visible to everyone, as the internet’s networks

across the world need to update this change. Therefore, due to the nature of the web, you

might temporarily be able to view your website on one computer but not another. Please be

patient whilst the web does its thing!

Your live website!



Now that your website is live, you're in control! You can update and edit your website's

content, submit your website to search engines, edit images and receive help and support.

We’ve created a content management system which means you don't need to keep popping

in and out of your local store and paying us to make lots of little changes to your website.

You can control your website yourself online by visiting www.updatecentre.com and signing

in with the account details which should be noted at the front of this guide.

Once signed in you’ll notice that the status of your site should now be ‘Your site is now live’.

Clicking on ‘Manage Site’, you will now see more options are available for you to edit your

website, add keywords and submit your site to google.

08

Maintaining your website
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Update your website
This is where you can edit or update your website’s content such as text and images.

Click ‘Update/Edit Website’ and you’ll be taken to a list of every page on your website. Each

page has a ‘View’ and ‘Edit’ button next to it. (If it’s not a menu page, you’ll also see a

‘Rename’ button which lets you rename the linked page).

The ‘View’ button simply allows

you to view a website page as it

currently appears on the web. The

‘Edit’ button takes you to the web

editor where the content can be

added and edited. To do this,

choose the page you wish to start

with and click the ‘Edit’ button.

N.B – The ‘index.html’ page is the

home page.

This will open the ‘Web Editor’* which is commonly known as a ‘WYSIWYG’ (What You See

Is What You Get) Editor. You’ll notice that the editor has very similar look and feel to common

word processors, making it very easy and familiar to use .(*The editor is a java based program,

you may be prompted with a java box, click on trust or allow.)

You’ll see the word-processor-like tool bar at the top. Use these tools to add content.
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Toolbar functions
Save: To save your work, click on the ‘save’ icon.

Print: See how your content is displayed in a web browser using a Preview
Window which then also allows you to print your page.

Spelling: Checks spelling of words on your page.  This opens the Check Spelling
box and shows the first word that is not in its dictionary.  You then have the
options to Ignore the misspelling, Add it to the dictionary, or change the word
to that shown in the change to box.

Find (Ctrl + F): To find and replace words or phrases within the text, select the
search feature. Enter the word or phrase you wish to find in the 'Find what’ field, and
press ‘find next’ to find it or ‘replace all’ to replace all instances with your chosen
alternative.

Cut (Ctrl+X): To cut a portion of the document, highlight the desired portion
and click the 'Cut' icon.

Copy (Ctrl+C): To copy a portion of the document, highlight the desired portion
and click the 'Copy' icon.

Paste (Ctrl+V): To paste a portion that has already been cut (or copied), click
where you want to place the desired portion on the page and click the 'Paste'
icon.

Undo: To undo the last change, click the 'Undo' icon. Each consecutive click will
undo the previous change to the document.

Format Painter (Ctrl+Shift+C): This option copies formatting from one item
- such as text, font setting and colours - to another selected area.
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Insert Image: To insert an image, select a desired spot on the web page you are
editing and click the 'Insert Image' icon. All the images uploaded into your images
folder will be displayed in this screen, choose the image from the list you want
to insert and click ok.

To modify the image properties of the selected image, right click (or on a Mac
Ctrl + Click) on the Image once you’ve inserted it and select ‘Image properties’,
change the properties as required then click the ‘OK’ button.

Remember: Don’t stretch or shrink images once they are on the web page - do
this beforehand. See the section called ‘Editing and Adding Images’ on page 16.

Show Paragraph Markers: Clicking this will show you where all your paragraph
markers and return key strokes are.  This tools can be very handy when you are
trying to layout and align your text.  Paragraph markers are shown as ¶ and enter
key strokes are shown as ¬

Redo: To redo the last change, click the 'Redo' icon. Each consecutive click will
repeat the last change to the document.

Insert Hyperlink: A Hyperlink is just a fancy name for a link to a different page.
To create a hyperlink, select the text or image you want people to click, then
click the ‘Hyperlink’ icon. You can select in this screen links from your ‘Current
Document’ or all of your available ‘Web Links’. You can also decide whether
you want the link to open in a new window by selecting ‘New Window’ from
the ‘target frame’ dropdown (otherwise it opens in the same window).

If applicable, to link to any of your ‘Linked Pages’, select the text or image to
create the link from, then click the ‘Hyperlink’ icon. Click on the Web Links icon,
you will be able to see in here all the Menu pages, linked pages, images,
documents and media you have uploaded to your website.  Choose the item
you want to link to and click the ‘OK’ button.

If you want a blank email to be created, prefilled with an email address of your
choice, use the ‘Email Address:’ Icon and you can select the email address and
subject line.
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Window View: You can use this to switch between a full window view and a
browser window view.

Paragraph Styles: To change the format of text, select the desired portion of
text and click the 'Paragraph' drop-down menu.  This tool should be used to
identify between different parts of your site, for example: Headings and text
should be differentiated by paragrah styles.  (Use a paragraph marker to identify
the end of your paragraph)  Insert a marker by holding down the Shift key and
pressing the Enter key.

Font Name: To change the font of some text, select the desired portion of text
and click the 'Font Name' drop-down menu.

Font Size: To change the size of text, select the desired portion of text and click
the 'Font Size' drop-down menu.

Bold (Ctrl+B): To bold text, select the desired portion of text and click the 'Bold'
icon. Each consecutive click will toggle this function on and off.

Italic (Ctrl+I): To convert text to italic, select the desired portion of text and
click the 'Italic' icon. Each consecutive click will toggle this function on and off.

Underline (Ctrl+U): To underline text, select the desired portion of text and
click the 'Underline' icon. Each consecutive click will toggle this function on and
off.

Justify Left: To align to the left, make a selection in the document and click
the 'Justify Left' icon.

Justify Centre: To align to the centre, make a selection in the document and
click the 'Justify Centre' icon.

Justify Right: To align to the right, make a selection in the document and click
the 'Justify Right' icon.

Insert Horizontal Rule: To insert a horizontal line above the area you have
selected.
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Colour: Select the text you require to change the colour of, then click this button
and select the colour you wish your selected text to be.

Unordered List: This options enables you to insert Bullet points before your
text. These have to be separated by paragraph markers.

Ordered List: This option enables you to insert number ordered paragraphs
before your text. These have to be separated by paragraph markers.

Decrease Indent: This tool enables you to reduce the indent of a paragraph.
These have to be separated by paragraph markers.

Increase Indent: This tool enables you to increate the indent of a paragraph.
These have to be separated by paragraph markers.

Highlight Colour:Select the text you require to be highlighted, then click this
button and select the colour you wish your selected text to highlighted.
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View > Code View: This menu option allows you to view the HTML code of your web page.

Don’t worry to much about this screen if your not familiar with HTML, however if you are,

you can enter HTML into your website here (our Editor is intelligent and will remove any

invalid HTML).

View > Document Navigator: Selecting this option shows you in a toolbar a break down

of the structure of the webpage your currently editing (depending where you have selected).

If you select to show this option then select a location on your page, you will then be able

to see the part you are editing and if its within a cell, or a table for example.

Insert > Bookmark: You can add bookmarks to your page, use this link to select the part

of the page you want your bookmark to be (this is the part of the site that when a link is

clicked you are taken to). You can bookmark an image or text. Once you have booked marked

and given the part of the site you want to go to a name, you then have to create hyperlink

to it. You do this in the normal hyperlink way as detailed above, but enter after the page

name a # and the bookmark name. For example index.html#bookmarkname.

Table > Insert Table: This option allows you to insert a table in your website. We recommend

you use a table with cells to position your website, as we feel this is the best way to make

sure your site appears consistently in different browsers.

Table > Merge / Split Cells: We have found many people don’t realise this function is

available and create tables within tables to try and achieve the layout required. We would

recommend inserting 1 table into your website with cells to place your text, images and other

content. A cell can also be used as spacing (or a gap). You can also merge cells and split cells

if necessary to achieve the required layout on your website.
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Forms: You are able to insert some common form layouts from this menu, or you can create

and customise your own form to insert into your website (creating and editing forms is done

within your Update Centre control page under the heading ‘Your Website’). More details on

this can be found under the support section of your Update Centre Control panel.

To learn how to use more advanced functions, please visit the
help & support section within your update centre. You will be
able to view help files and demos.

Table > Cell / Row / Column / Table Properties: This options is used to specify the setting

of your tables structure. The more information you can enter in here against each cell, row,

column and table will help make your website appear consistent in all browsers.



It’s easy to add images to your website! You just need to remember one thing; images used

on websites must be optimised for the web. All this means is that the quality (size and the

file size) must be reduced. If this isn’t done, then an image could fill the screen and take

forever to load.

So what do you need to do? Not a lot really because we’ve created a tool to do the hard

work for you. It’s called ‘Online Image Editor’ and you don’t even need to download any

software on to your computer to use it – it can be easily accessed through the Control Panel

or Web Editor.

If your images are already uploaded and optimised you can easily insert them by selecting a

desired spot on the web page you are currently editing and clicking the 'Image' icon on the

toolbar then select the image you wish to insert from the list.
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Editing and
adding images
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However, if your image is not yet optimised for the web you will need to use the ‘Online

Image Editor’. There are two different ways you can open the image editor.  You can either

open it from your website control page, by clicking on ‘Online Image Editor’ under the ‘Your

Website’.  Or from within the page you are editing you can click on the insert menu then

Image Editor.

N.B. – A pop-up may appear asking if you trust the author of the image editor. That’s us,

so yes, click to confirm that you trust the source and wish to proceed.
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In the Image Editor, click the ‘Add Images’ button and search your computer for the image(s)

you would like to edit. The images must have a file extension of ‘jpg’, ‘gif’ or ‘tif’ (e.g.

imagename.jpg).

Once you have located the relevant image you should select it and click the ‘Open’ button

to add it to the Image Editor. You can add multiple images if desired.

To rotate an image: Click on the circular icons on the image to rotate the image 90 degrees

clockwise / anti-clockwise. To confirm that you wish to complete this action you should click

the tick icon or alternatively to reject it; click the cross icon.
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Cropping an image: Select the image you wish to crop and click the ‘Crop Selected Image’

button. The image will appear in the bottom screen. Move the selection box around to choose

the area you wish to crop. Once you’re happy with your selection; click the ‘Crop’ button.

To reject the cropping of the image, click the ‘Discard Changes’ button. When you’re happy

with the cropped image, click the ‘Save Changes’ button to update the image.

Resizing an image: Select the image you want to resize

and click on the ‘Resize Selected Image(s)’ button. This will

bring up a pop-up box with three different options for resizing:

By Pixels – Make the image smaller by choosing a lower

number of pixels (the dots that make up an image). You can

choose to constrain the proportions of the image (so as not

to squash it) by ticking or un-ticking the relevant tick-box.

By Percentage - You can make the image smaller by choosing

a lower percentage of the current size.

Various fixed sizes – You can choose from five different fixed

sizes; Very Small (200 pixels), Small (400 pixels), Medium (600

pixels), Large (800 pixels) and Extra Large (1000 pixels). The

image editor will convert the largest side of the image (either

width or height) to the chosen fixed size (i.e. Medium will

become 600 pixels).
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Now you’ve uploaded your web optimised images you can now insert them into your web pages.

To modify the image properties, right click on the image (if your using a Mac, hold down the Ctrl

key and click) and click image properties changing the details as necessary then the

‘OK’ button.

Uploading the image: When you are happy with your image, select it by clicking on it and

then click the ‘Upload to the Web’ button. This automatically optimises the quality of the

image for you and uploads the image to the same place as the rest of your images. Use the

‘Select All’ button prior to uploading to upload all the images. Alternatively to select multiple

images you can hold down the ‘Ctrl’ key and click the chosen images.



Do we offer search engine optimization? This is a very grey area and not one we get involved

in. Be suspicious of anyone who guarantees to get you #1 spot on search engine listings –

what they’re doing may get you banned.

Here are Google’s thoughts on search engine optimisation:

“A few unethical SEOs have given the industry a black eye through their overly aggressive

marketing efforts and their attempts to unfairly manipulate search engine results.”

Visit the following link for full details of Google’s opinions:

http://www.google.com/support/webmasters/bin/answer.py?answer=35291

One thing we can tell you, however, is that one of the most important elements of a website

that will affect search engine ranking is content. It’s common sense really. If the website is

promoting widgets and there is no mention of the word ‘widget’ or any other associated

terms then the website will struggle in search engines. It’s basic marketing really… you

wouldn’t sell widgets and not tell people that’s what you do, would you?

Whilst we’re not offering search engine optimisation, we’re certainly not anti-search engines.

Your website has been developed to be as search engine friendly as possible and there’s an

area available in Update Centre where you can add search engine keywords, titles and

descriptions for every page to help get your website higher up the search engines. We

recommend you enter this information. Also, check out the link in our control panel called

‘Google Web-Master Tools Verification’ which explains how to submit your site to search

engines.

If you submit your website to search engines there is no guarantee that
you will be found. It may also take literally months before you’re even listed.
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Search engines
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There are two options when adding search engine keywords. Either add keywords for each

individual page or simply use the same keywords for all pages of the website.

For best results give each individual

page its own keywords. Do this by

clicking the ‘Edit Keywords’ button next

to the page name and entering the

keywords. By doing this, if someone

types a keyword into a search engines

that is only relevant to a specific page of

your website, they should be able to click

a link to go directly to that specific page.

The other option is to add keywords for the whole of the site. Obviously this is less time-

consuming for you, however, it will mean that the end-user will not necessarily go to the

relevant page that shows the information they are requiring, instead going to the home page.

Do this by clicking the ‘Edit Keywords’ button at the bottom of the page next to ‘All files in

this directory’ and by entering the keywords.

The same procedure is used for the title and description sections.

Search engine keywords,
title & description



Macintosh

Mac OS X 10.2.x
Latest version of Mozilla Firefox
(The latest version of Java is needed
and should be automatically
downloaded with Firefox)

MINIMUM SYSTEM REQUIREMENTS

PC

Windows XP
We recommend using the latest
version of Internet Explorer
Latest version of Java
(Downloadable from java.com)

Alternatively the latest version of
Mozilla Firefox (The latest version of
Java is needed and should be
automatically downloaded with Firefox)

This guide has been designed to answer most of the common questions you might have

regarding your website and Update Centre. However, there’s also a ‘Help and Support’ section

in Update Centre. In this section are four links;

FAQ
This has up-to-date Frequently Asked Questions.  If your trying to do something and your

unsure how, check in here as your question may already be answered.

Help Topics
This has up-to-date help files explaining how to perform the latest functions in Update Centre.

Just like this guide, you will be able to read instructions along with screenshots to help you

through using Update Centre.

Online Demos
This section includes demos video’s, showing you how to execute certain functions.

Request Support
Here you can submit a contact request form.
We’re happy to provide as much support as you need. If you’d like us to do all your updates

for you, that’s fine. If you want us to spend time with you and walk you through the Update

Centre process, that’s fine. In fact, we’re happy to spend as much time with you as you need.

We’ll simply charge you our usual hourly artwork rate, with a minimum of just 15 minutes.

Need some help? Pick up the phone or drop us an email.

Help & support
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